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SS9 FE) 7% (ReaxFF MD) A& —Fh A 5y1 RO A A5 OB R 2 2% 3 SE kAT HLERIIE 7C (14— Ry 2807735,
HAVFED T RGE T FET H R BER A E BT R N B . 72N o313 g 2 IS Rk e it 9
TR EARE R4 S B FE A (S N AL SR 4 T — R ATIR I35 AR, FE BT A Rk
LR FR G RS B 1 PRk, SO 231 3l 7 “E AL AT LASRAS L I (B0 20 1) S AR AR 8874 S5 B
Fooy P REEEE . RT3 7750 R TR CRT 10000 /N J50T) 1 RS, THAT X () R AR,
RGN, N oA HLERRE 9% & (I (ARG /3 9F AL . DL AutoRMA BT A, 5 AE 9B FEN SR —
Tt EEAN Sy AT LA W] PR USE 531 80 0 S ARG R 2 B 5 TR R T a7 5

1.2 WHANH

AutoRMA(Automatic Reaction Mechanism Analyzer) = F8 A< E 5 ReaxFF JX N HLEE 8 1F -

AutoRMA = E 534 AutoRMA-Full(f&# AutoRMA) F1 AutoRMA-Lite fix 4s, H:# AutoRMA-Full EH Lammps-
ReaxFF ¥)Fh (531 SCAF 5B BB Py AERZE 43 i BB 7, T AutoRMA-Lite /& AutoRMA-Full 748, EE RS T
YRy (93 F) SCHERI 8T, LR GEFRN AutoRMA, JED BEAMEURE T X 43 -

1.3 PishhAs

% 1: AutoRMA-Lite iR A< 5%
WAS  KkAHB  XEFPFE EHEER

2.0.0 2025.03.27 Windows KA\
2.0.1 2025.04.10 Windows  SCEFUIRSCHE NG R IR T 04T
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% 2: AutoRMA-Full iR At 3
MAS  RAEEW XEPFE BEEER
2.0.0 R AT Windows & Af
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CHAPTER 2

i 5

2.1 ReaxFF &3 =4 fEi/

2T Lammps [) ReaxFF(7> 13l /7 5%) B A4 /5 2P R 3 4% 7139 301 R R G & I8 1 I 1135 2400
1 (LT AR S HOC) AR TARFR SO (AR TIRRARHR SCAF) S5 AR SCF . ReaxFF RSP AT DAA: e 55 A i
TR Y S, B JR T ARBR IR SO AL S 2 A5 20 2 73X, B = AN SO R SREUBAI S R 0 3
B ARG UL TR AT PE AR ) ReaxFF AU 8 ds, H oW om0, SO RABGE o 1F v e W2, (H
AutoRMA AFER T PE i i3l 77 A A4S R 7 fr, FLnT BT BT AT K ReaxFF A54LL45 SR 20 # A A K 1)

AR

2.2 i3RI

AutoRMA-Lite & 711 3CAF#17 70 97, 4£ Lammps W A] PLEA PLR 745 o A7 fix reaxff/species PA 1 fi#

CEAETSE

# Syntax

fix ID group-ID reaxff/species Nevery Nrepeat Nfreq filename keyword value ...
# Examples:

fix 1 all reax/c/species 1 1 100 species.out

Hig e

AutoRMA - F 87 A F R SCAF, Pulki S rf i, dn R iy 2 =2 n] YL DY e, W ZB2 (o

B AR Lammps HA] LLd LR a4 5o AIU7 ] fix reaxff/bonds PA T 58 245 ..

# Syntax

fix ID group-ID reaxff/bonds Nevery filename
# Examples:

fix 1 all reax/c/bonds 100 bonds.reaxc

Hag s

I SCAFAE Lammps HA] Ld T PLR Ay 45 e ATUF A fix dump/lammpstrj BT fEE 245 5 .



https://docs.lammps.org/fix_reaxff_species.html
https://docs.lammps.org/fix_reaxff_bonds.html
https://docs.lammps.org/dump.html#dump-custom-adios-command

AutormaUserManual, K1THZ v2.0.0

No_Moles

Timestep  No Hole;

00 6

Timestep  No_Moles

No.Holes

NoJ-Vole;

No.Holes

No_Mole:

No_Mole:

No_Moles

No_Moles

13

No_Moles

Timestep NoJ-\olsz
4400

12
Timestep  No_Moles
4500 13

Timestep 3000

Number of particles 1804

No_

No,

No_
No_
No_
No_
No_

No_

Spec
Specs
Specs
Spe(;
Specs
Specs
Spec:

Spec

No_S

No_

No_
No_

No_

1

Specs
Specs
11

Specs

H521
1
C300H602
1
C260H521
1

H521

1
C260H521
1
C260H521
1
C260H521
1
C260H521
1
C260H521
1
C260H520

1
C260H520
1

C40HB1
1
C78H157
1

C40HB1

1

C40HB1

1

C40HB1

1

C40H81

1

C40H81

1

C40Hg0

1

C40HZ0

1

H2

1

H2

1
C52H103
1
C151H302
1
C151H302
1
C151H302
1

C2Ha.

BH15:

[

7
1
H
1
H
1
0
1

C40HE0
1

H2

1
C52H103
1
C52H103
1
C52H103
1

H302
1

CasHIL

1
C177H354
1

C2Ha
1

8H157

1
C78H157
1
C78H157
1
C78H157

C40Hg0
1

Max number of bends per atom 4 with coarse bond order

Particle connection table and bond orders
.id_nb mol bo_1...bo_nb abo nlp q
0.000

id type nb id_1..

1154 2 1 1151 @

21
21
21
021
21
14

4 2 1 861 8

8 869 867 @

Cas5Ho1
1
C175H350

1
C175H350
1
C175H350
1

C175H350
1

C2HA
1
C2HA

1
C2HA

1
C78H157
1

C40H80
1
C40H80
1
C40H80
1

H2
1

C45HI1
1
ca5Ho1

1
C175H350
1

C19H38

1

C19H38

1

C2Ha
C78H157
1
C78H157
1
C78H157

1

C40H30

CasHo1

1
Ca5HO1
1

C156H312

1.046

.049
.44

0.050

.895

.051
0.031

0.063
0.061

B 2.2: 4P SO R

i

&l

y

v

N

CasHOL
1
CasHIL

1
C111H221

C43H87
1
C111H221
1
C111H221
1
C111H221
1

C111H221
1

C45H91

C45H99

0.000 -0.090
0.000 -0.086
0.000 -8.124

0.000 -0.079

0.000

9.000

Chapter 2. fFfH&
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# Syntax

dump ID group-ID style N file attributel attribute2

# Examples:

dump 1 all custom 100 pe.lammpstrj id xu yu zu

Hig e

ITEM:

3000

ITEM:

1804

ITEM:
-9.425

TIMESTEP
NUMBER OF ATOMS

BOX BOUNDS pp pp pp
5918000000

-@1 2.3148644082000001e+01

-3.250004421999999%+08 2.0841195578000001e+01
2.6559692299999998e-81 2.4356796923000001e+01
ITEM: ATOMS id xu yu zu

0.640706 0.96

3.23007 3.70609
-73621 27.5419
-33963 3.74946
.37656 4.78081

o -86947 4.76562
0.709143 0.110315 28.0005

38856 0.163741

28.0612

8974 -0.741032 26.1289

1146 23.9808 1.98144 4.75033

1558 1.54212 0.

864 3.71024 21.1505 3.0416
1566 3.14526 1.92751 24.5357

855
1550

21451 -2.68529 5.8

3.53304 1.87065 2.47816

.7609 2.28136 5.96712
.34545 1.26484 5.63912

-55889 -1.20058 24.8411
-73231 -1.81775

30285
-1.77214 7
4.40778
2.1662

5543

335117 26.0284

2 26.0226

3: | 2.3: b SRR

2.2, HTCAEREISY
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CHAPTER 3

Lo = o 7 Y
g L]
3.1 T#
M AutoRMA B 7 sl T 8k e, 225 UM i
AutoRMA E M R [: https://www.autorma-sw.com/#section-download
AutoRMA & #f R N #H B B https://www.autorma-sw.com/downloads/autorma-lite/

AutormaLiteSetup-windows-x64-latest.exe

3.2 #3

1.

SN U T

ikt A T IR 2, i A A
(AEACIDSVEE DRy S

PR AT

A o 1 PR T 2o

ZRAF BN

3.3 BUETEM
A 2 25 5E R RS A T AT . WS WA T S5 B WS U B hitps://www.autorma-sw.com/

#section-buy



https://www.autorma-sw.com/#section-download
https://www.autorma-sw.com/downloads/autorma-lite/AutormaLiteSetup-windows-x64-latest.exe
https://www.autorma-sw.com/downloads/autorma-lite/AutormaLiteSetup-windows-x64-latest.exe
https://www.autorma-sw.com/#section-buy
https://www.autorma-sw.com/#section-buy
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ffl Select Setup Install Mode .

= Select install mode

Autorma-Lite can be installed for all users (requires
administrative privileges), or for you only. |

% Install for all users (recommended)

— Install for me only

[ 7d Setup - Autorma-Lite version 2.0.0 = X
| License Agreement -
Please read the following important information before continuing. .

Flease read the following License Agreement. You must accept the terms of this agreement before
continuing with the installation.

Automatic Reaction Mechanism Analyzer BFPEES RN

EERT FESESE (BREEE) . (SHSHERIN REMTeE. R
| (LITFEHF S ) . EREAERE. T8RN, FERVSRSRE. mAiEEsE |
i, EEFEEREENSSRESETAEN. EEME. =EFEEAutomatic Reaction Mechanism
Analyzer (TFIrfedR “AutoRMA") FFAREMETCY (0E) | SEREESENEFETEEES [
B, BEEUTREERNYPOENTAEE, EEREHEE Rl ESETaEET, &
AutRMARSZERENETE, IRETASETFNAEEES, ST, SFSEE |
HHMUATEES, ETE. =2 GENEETHERESEEEEET RN RAuRMARE S !
=N, EEESREEEFVEEFRS, TSR RAEEERE. BERAE AR
IR, EFTREE T EE, SEREEE, MRS ESERETTELATE,

I

| ()1 do not accept the agreement

8 Chapter 3. %3
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#l Setup - Autorma-Lite version 2.0.0 = x
Select Destination Location .
Where should Autorma-Lite be installed? .
[ F Setup will install Autorma-Lite into the following folder.

To continue, dick Mext, If you would like to select a different folder, dick Browse,

C:'\Program Files\Autorma-Lite Browse...

At least 65.0 MB of free disk space is required.

ffl Setup - Autorma-Lite version 2.0.0 = X

Select Additional Tasks —
Which additional tasks should be performed? .

Select the additional tasks you would like Setup to perform while installing Autorma-Lite, then dick Next.

Additional icons

3.3. BudEEM 9
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#l Setup - Autorma-Lite version 2.0.0 = x
Ready to Install . [
Setup is now ready to begin installing Autorma-Lite on your computer, . |

Click Install to continue with the installation, or dick Back if you want to review or change any settings.

Destination location: A
C:\Program Files\Autorma-Lite

Additional tasks:
Additional icons
Create & desktop icon

Back Install Cancel

ffl Setup - Autorma-Lite version 2.0.0 —

Completing the Autorma-Lite Setup
Wizard

Setup has finished installing Autorma-Lite on your computer. The
application may be launched by selecting the installed shortouts,

Click Finish to exit Setup,

10 Chapter 3. Z3$HF



cHAPTER 4

B

AutoRMA F SN 3.1 Frow, HAREFE . SRFs. TR PO FRSEM . SERAE 2 A File.
Tools. Settingss Window £l Help ZE 1, £ 0 3 E5 B R o

4.1 PRt

BRAUAE AT B 1 TOUAE, o= B RO B 224 3% 30 1 A2 A4

11
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4.2 FEHRFE

SR T AR A R 7, $RAE T XA D RERI UG R o TS AT
1. File
o New: Hrt T
 Open: 171 T#2
* Close: X[/ L%
o Export: FH 287 3% HHRM . 2 BSOSO
* Exit: i H 3
2. Settings
* Open After Export: 3 H U2 5 2 14T

 Dump Readable Results: 5 HH AL 7T 45 R (O THE . TR, (WP RNEE. A8 E e d5E), 3R
K esv A% R

3. Tools
* Visualization Trajectory: RJ f{ALAB L EN 2B
* Generate Data File: T MS 5 H /) car A1 mdf SC#F, 2 i Lammps #4857 75 4 data SC2F
* Extract Force Field Data: $£H0 173% 2%, £ i Lammps #4057 75 14 /13% params A4
4. Windows
* Style: $Z{ft Native("E77) Light. Orange F1 Dark F [ X% A] % 4%
5. Help
o Team: [1B\E B H
* About: # B SRSAI AT SCRHE B
* Update: BARAAG 7 J2 56 4T

4.3 T EF

T AR T2 AL R T7, SR it 1 bRy i % FH DD RE #2411 5 S A b B i AFDRE I, 7 B P R
BAE, ARSI .

4.4 LA

FOEERFETEXE, FEATIENTERES, FETHOARE:
o HW: a7 TRER H 4ty AT 2 b
s AGMERE: KUl TAEREF. Timesteps HEH, L T AT
o TEANGE S A0 H SBARXS R, o Tk h ) B RS B, EEOERK . 2D/3D K5
o BEFEFR: MHTHRAE R TS R

12 Chapter 4. ##EAH
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4.5 REE

RS T E R

WoR A AR RS

13

4.5. RER
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CHAPTER D

(ISUPIRE

X/

5.1 4 param.qeq (44
7E Lammps #47 ReaxFF B A2 b, 72005 7 AT 2D A58, LUCRFF R G0 T . LA AR T SR
FH DA 433k QBQ 7 ke B 4 47 8L, T L fix B TR 245 .

[fix 1 all geg/reax 1 0.0 10.0 le-6 param.geq
Z 4 param.qeq N E QEQ T TS HHISTA S, AT LLA 137 LA L, AutoRMA #2488 T iZDhRE .
LA fa] SR AR R BL B RO |-

1. RT3 HAE Tools->Extract ParamQeq File 5 #1824~ Extract ParamQeq File 1% £ T FFERAFTHIAR, S (ik
) 715 SO S B8 AR S5 ridls Extract 58 18 55 00 5%, LA 15 SCIFIGZE T H BT R SCHFAE AR

#4341 PDF. Word % & XX AN 5L .
2. ) ParamQEQ S U N i, T BHE BN, 7E1R ML Lammps (EHRS, R R AT ds 1970 F A7 IR

LL# FTUG HFITETE P2 o

5.2 ARk data 304
7E Lammps #t17 ReaxFF 4IRS, AJiE i read_data dy &3 IUE & R F 8040 T RS WG & SO, i gr
B AWML . ATV ) read_data A T EE ZE R

[readidata pe.data
ZAn A pe.data NFFE— E MR FRECE SCF. Al —Mor !
1. {# F Material Studio (LA F &j#% MS) #EATEAH, S H car/mdf 344, 7] 5% F|F MS A Lammps ReaxFF
1L (PE/SE 205 2:Aih-2
2. FH Lammps 32 (L F) msi2lmp T E #4755,
N7 EAE DL A AT 2 filfh data SCAEEE N 2, AutoRMA 2L 7% MS 5 H ) car/mdf 0544k R data SCA
FIThRE . AT faj SRR v s AR B

15


https://docs.lammps.org/fix_qeq_reaxff.html
https://docs.lammps.org/read_data.html
https://www.3ds.com/products/biovia/materials-studio
https://mp.weixin.qq.com/s/jGaA4DlT52LYmZf41DRIkA
https://mp.weixin.qq.com/s/jGaA4DlT52LYmZf41DRIkA
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ffl Extract ParamQeq File X

ogram Fi L ffield.reax

dmin/Documel Juntitled.p

Extract

1: & 4.1.1: $#2H ParamQEQ {5 S5

-
Wl Extract ParamQeq File X

#C
1.0206 #H
1.0503 #0O

Extract

2: K 4.1.2: ParamQEQ W& 4 B BN

16 Chapter 5. H#EF
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1. SR Tools->Generate Data File 2.5 1. 2.4 Generate ParamQeq File %41 T BRI, 3H'S (ik
FE)car/mdf SCAFFIA CSCAF AR, W BA RS S fith Generate 154 -

#l Generate Data File - [m] b

iles/Autorma-Lite/examples\pe

'admin/Documents/AutoRMA-Lite/pe.data

4
M
O
¢ |\a
]
O
]
4
O
]
O
]

Generate Exit

K 3: | 4.2.1: £k Data AFERIEE

2. miili Generate 2 J& 25t IR 15 BB AT, @1 K BIFoR, fE 0L, 774 =R 1 H,C2,C3 =F 5 1,
{BAE PE Vi, Ak C2/C3 [N C, A AN 728 R bRl RIS SR b e 25 X7 C2
A C3 M2 B CCH4 [WRh, 2o FLREE, MY R I C2H4. 428, 2 7 BINRLH, 7 B
FOFULITE . A5 75 ZEEAT A SRACBE, W a3 oh VA 2810 JR 15 i 7 Merge FAHBITT . WA 75 BUS
s OK #%4H.

3. AR Data SCHESE A0 R B FTR, AN msi2lmp A2 B HI R IR EE SR, M AFAE LB G I 4E 5. A2
BRI A B i, 35 BN A, AR TP SR N B 4RSS 5 s ik Update $28RIW] . 75 EUERHE, 4
B R 2RI B Full 22 Charge B Atomic, 7% BB UG &t T 7 Generate 3247 2 5714 i

5.3 2T species ({4

Lammps 7] EL#% F tH ReaxFF 540 A= )W Fh (Species) Xk AHIAZ BRI 255 70 3L AF T 7o
AutoRMA-Lite [ F Z IR 2 S M SO 0 #r Dhfe. BLR e s s R s DL POE B,

1. #T7F AutoRMA #1451+ *Create a new Project®, s i *OK* &4 J5 e A W H M &. Mo tnr Ll
L SEEFE (File->New) 5L T ELFE (New) #2450 T 4G5 &5 H -

2. IEFEHT D H KA, FFEF BN AutoRMA K REILFE *Species-Based, Bonds-Based R AE. AutoRMA-Full fix
ARG *,

3. 5T HBAEME FRSEEE. KR 75475 due 7t 27U, bndi’s C A,
W57 C2H4 &7~ h C2H4 3 #5385 H C, W9 F C2H4 B7ny HAC2. Wik ¥ B ERINBI AT, BARA 2R LG
SLEETVERE

4. St se s, v LU A

5.3. 42T species X 17
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f #/l Confirm Data Atoms x

Expend Merge

Cancel

Kl 4: 422 G124 70

r #/l Confirm Data Atoms x

Expend Merge

Cancel

5: & 4.2.3: &R S AR

18 Chapter 5. H#EF
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7/l Generate Data File — O x

C:/Program Files/Autorma-Lite/examples\pe

C:/Users/admin/Documents/AutoRMA-Lite/untitled
I
evit

Update

Kl 6: & 4.2.4: DataFile N & 45 B~

#l Welcome to AutoRMA X

7: B 4.3.1: FiaHEmH

5.3. 4r# species X1 19
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#l Choose Create Project Type X

K 8: B 4.3.2: iEF T H KA

fl Create Species-Based New Project X

Cancel

K9 K433 HEHHER

10: & 4.3.4: S Hr 5%

20 Chapter 5. H#EF
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54 fTHEAHAH

1. f£3TH AutoRMA 31 5% FF Open An Existed Project, %% J5 7] LA N 75 Recent Projects FIi %)% Hik 2
HIH, Bl Browse LB S RHENEL £ B E2 I0 H 724 1 Elorma 5% (19 3CAFIG ik *OK* LAFTHF
TUH . 2SR A] OB SR BAE (File->Open) B T HF (Open) 4T A TH .

# Welcome to AutoRMA X

Create A New Project

C:/Users/admin/Documents/AutoRMA-Litefuntitled.rma

11: B 53.1: $THWH
2. FTIF5ER, AT DU 5 i

54. FTFEFTH 21
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12: & 5.3.2: FTF 52 5%

29 Chapter 5. {REFFH
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